SIMULATION OF
PERSONAL RAPID TRANSIT

A tool to examine the operation of a PRT network constructed across a site of your own choosing

INSTALLATION GUIDE
AND TUTORIAL
1. INTRODUCTION

Personal Rapid Transit (PRT) is an innovative new form of public transport in which small, automatic vehicles travel on a special network of guideways. Passengers board a vehicle at an access point and travel to any chosen destination directly, without stopping on the way.

The ATS/Citymobil software enables you to demonstrate a wide range of potential PRT applications using any configuration of guideways within an area of the user’s own choosing up to 5km square. It enables the user to:

- build a network of guideways, stations and depots against a map of the area selected
- edit the network, changing interconnections and stations
- determine the level of demand at each station
- either allow the simulation to construct an origin-destination matrix accordingly, or adjust the matrix by hand
- run the simulation, either in real time or much faster than real time
- see how the individual vehicles are controlled to wait at stations until passengers arrive and then directed to the requested destination station
- see how empty vehicles are called to stations where passengers have arrived when no vehicle is waiting
- see how many passengers are waiting at each station
- see how many vehicles are at each station, waiting empty, unloading or loading passengers
- see the mean waiting time at each station and overall, and the number of vehicles required

The specification of the PRT network is that of ATS Ltd’s ULTra system of 4-seater battery electric vehicles (see http://www.atsltd.co.uk/). The operation of other PRT systems will be different in some details. All stations are off-line, and the maximum speed is 40kph. The ULTra system has been operating on ATS’s Test Track in Cardiff, UK for several years now, and is currently being installed at Terminal 5 of London’s Heathrow Airport. When it opens in 2009, it will be the first operating PRT system in the world.

Detailed design of an efficient PRT system is a specialist task, and depends upon the particular location and pattern of demand, so this general-purpose simulation should not be viewed as a complete design tool. It is, necessarily, a much simplified version of the comprehensive simulation packages used by ATS Ltd to examine and develop a PRT network, and is therefore limited in the size and complexity of the networks it can handle.
In particular, the control system embodied in this simulation is unavoidably sub-optimum: it omits the Battery Management System essential to keeping the vehicle batteries charged, and its Empty Vehicle Management System is not tailored to a particular network, as it would be in reality. Thus the simulation should not be regarded as a complete indication of what PRT could do in a particular application. Provided the user designs a sensible network within the simulation’s limitations, however, it is a helpful tool in providing an understanding of how PRT might operate.

It is not to be expected that the inexperienced user will be able to design a network of high efficiency, or one which will work near the limits of capacity. Where the application runs into difficulties of this type it would be necessary to obtain expert assistance from experienced PRT developers. For any application, they can be expected to design a network which is more efficient, in level of service, number of vehicles and guideway length, than a network constructed by the lay user of this general-purpose simulation package. ATS will be happy to consult on these matters.

2. INSTALLATION GUIDE

Unzip the supplied package “atscitymobil-setup” and copy the setup file into a directory of your choice. Double click on “atscitymobil-setup” and the install wizard will guide you automatically through the process.

Note that the ATS CityMobil software requires the Java™ platform. Most computers come with Java pre-installed. If you do not have Java installed, you can download it for free from http://www.java.com/en/download

3. GETTING STARTED

The installation ends with the “Run” box ticked, so that clicking on “Finish” will launch the program automatically. Once ATS CityMobil is successfully installed, you can launch the software by any of the usual means – from the ‘Citymobil’ icon in the start menu, etc. You should see a screen looking like this:

The ‘Open’ pop-up box offers three options. We’ll look at the tools for creating new networks later, but first click on ‘Open Case Study’ with either “Urban Case Study” or “Airport Case Study” highlighted to quickly understand how the simulation works.
The network you have selected will appear on the screen. The PRT guideway is represented by thick black lines, with passenger access points (stations) depicted as blue circles and vehicle storage depots shown as yellow diamonds. The direction of flow is shown by white triangles.

Click the ‘View’ option on the main menu at the top of the screen, and use the commands there to look more closely at the selected case study. You can also use the mouse or keyboard to change the view. Right click and drag, or use the cursor keys, to move around. Use the mouse wheel, or the square bracket keys [ ], to zoom out and in.

Click the ‘Run’ button in the top left hand corner of the screen. After a short time you will see vehicles moving around – these are represented by green and red spots on the screen. The simulation is initially set to run in real time. To speed up operation of the simulation, click on the ‘Faster’ button in the top right hand corner of the screen.

If the simulation does not run, you may have inadvertently altered the network. The green tick at top right shows whether the network is complete. If not, try reloading the network (from the file menu) and try again.
4. THE DISPLAY

The simulation runs for a greatly accelerated 30 minutes unseen before the screen display opens, so that the system is fully loaded.

At stations, vehicle berths are shown as small circles. Empty berths are white. Vehicles waiting at berths are coloured according to the vehicle colour key, shown at bottom right of the screen:

Green: When passengers board a vehicle it becomes green in a station, and once boarding is finished the vehicle automatically starts its journey and is displayed as a green moving spot.

Blue: When an occupied (green) vehicle reaches its destination, it usually takes around a half a minute for the passenger(s) to disembark. The vehicle’s colour is changed to blue during the unloading phase.

Red: Once the vehicle has been unloaded, it is ready to carry another passenger, and is coloured red as it either waits in the station or is moved to another station or back to a depot.

Grey: Sometimes occupied vehicles have to wait momentarily in a station for a time slot to be cleared throughout their journey and are coloured grey while waiting.

In times of low passenger demand, many (red) empty vehicles can be seen waiting in the stations. If a passenger arrives and begins boarding a vehicle, that vehicle’s colour will change to green. Normally the boarding process takes about a (variable) half a minute, so you can see a number of stationary vehicles displayed in green at any moment. This can be hard to see if the simulation is running faster. If a passenger should arrive at a station with no empty vehicle available, that passenger must wait until a vehicle arrives.

Waiting passengers are shown by a numerical display at each station – this is zero if no passengers are currently waiting. The timing of each passenger arrival is completely random. This is controlled by a random number generator within the software and is an important part of the simulation. More detail about passenger demand levels is given later on. Each ‘passenger’ represented by the simulation is in fact a group of passengers travelling together, and up to four people can be carried in each vehicle.

Moving vehicles:
The vehicles all travel at identical speeds, and are automatically controlled by the ‘synchronous’ control method. Every journey is given a uniquely different timing so that vehicles always arrive at merges with adequate separation between them, at a minimum 3 second headway. This may be hard to see at certain magnifications – use the ‘zoom in’ control to see what’s really happening at the merges. The vehicles keep going until they reach the passenger’s chosen destination – they do not stop at any intermediate stations on route.
All the stations (and depots) are assumed to be ‘off-line’ i.e. the loading/unloading berths are physically separated from the guideway. Thus vehicles can continue travelling past the station at full speed without affecting the vehicles parked at the station or the passengers getting on and off. Stations can be of any size and shape in order to integrate with existing architectural features – this is NOT represented on the screen display. In the simulation, all the stations are represented as idealised circular shapes. Although the software does not allow detailed station design, the guideway lengths, journey distances and times are all accurately represented.

Each station shown on the screen has up to five vehicle berths, which are displayed as white spaces if there is no vehicle currently parked in them. Note that when vehicles occupy the berths, their positions are NOT displayed realistically because the berth displays are filled clockwise – if only one vehicle is present in the station, the least clockwise berth display will be illuminated, if two vehicles are present the two least clockwise displays are illuminated and so on. When one vehicle leaves or arrives at a station, it may appear that the remaining vehicles move along from one berth display to the next. This is a product of the display only, and is not representative of the way a station operates in practice.

When running, the screen shows the elapsed time and the mean wait time so far at bottom left. The distance scale and key to the vehicle colours is at bottom right. Holding the cursor over a station brings up a box summarising the current status of the station. At top right, “Fast forward” stops the dynamic display and calculates the rest of the simulated period very rapidly. At the end of the 2-hour simulation period, the results screen summarises the mean wait time at each station and overall, the percentage of passenger groups waiting less than 60 seconds, the numbers of passenger groups carried, and the number of vehicles used. This simulation does NOT optimise the fleet size: it calls up as many vehicles as are required to respond to passenger calls: in practice fewer vehicles might be provided and the mean waiting time would be somewhat longer. The “Stop” button (top right) stops the simulation at any time, and displays the results so far.

5. USING THE GUIDEWAY EDITING TOOLS

Make sure the simulation is stopped (click ‘Stop’ and close the results box). Click “File” and “Open”, and open the “Editing Demonstration” case study.

Click the ‘Edit’ button at the top left of the screen. Now you can use the mouse to move elements of the network around. Place the mouse over part of the network and click and drag the network element to a new location.
Whole track sections can be moved, and nodes can also be moved around, whether they are depots, stations, or plain track nodes. Track curves can be edited in two ways. Click the mouse onto the white square node point by a track curve. The node turns green when it is selected. You can then drag and drop the corner to a different location. Alternatively, once you have selected a particular track curve a handle or pair of handles will appear coloured orange or magenta. Dragging the orange/magenta handle will change the radius of curvature of the track without moving the position of the rest of the track. Note that when editing curves on a large network it may be necessary to move to a high “zoom” before the curve radii and handles can be seen.

The “Edit” menu at the top of the screen allows you to delete or reinstate editing changes. If you click on a station or track section, so that the relevant white squares turn green, this menu also allows you to delete the selected item. In the “Editing Demonstration” example, if a station is deleted there is only one left, and an error message will be given at the top right of the screen until another station is inserted. Note that when a track section is clicked so that nodes at each end turn green, both nodes and attached track sections will be deleted, ie three sections if two nodes are highlighted: if a station is centred on one end of the indicated section, it will be deleted. It is better to click on a single node and delete it and the two track sections attached on either side.

6. CREATING A NEW NETWORK

First clear the screen by selecting ‘New’ from the file menu. After deciding whether or not to save any unsaved changes to your own file, you will be prompted to import a background picture. For now, select ‘Do not use a map,’ and click on ‘Finish.’

Click the ‘Build’ button on the top left of the screen and you can begin to design a PRT network. First choose where you want to put stations. Position the mouse appropriately, then click and a dialogue box will appear. If you simply click ‘OK’ a station will appear. There are also options to control the relative passenger demand at the station by using the slider or to make a vehicle storage depot instead. You can name each station, or simply accept the default numbering. Create as many stations as you like, up to a limit of twenty. Note that you must have at least two stations and one depot for the network to be viable.

Once you have the stations in place, you can begin to link them up with guideway. Position the mouse over one of the stations, press and hold the mouse button and move the mouse to an adjacent station. If you release the mouse button whilst the mouse is positioned over a station, a section of guideway will appear linking the two stations. Alternatively, releasing the mouse button whilst the mouse is not positioned over any station will create an intermediate node – the track will appear to end at this point. Continue the guideway by positioning the mouse over the end point, drag and drop the mouse as many times as you like to create complex guideway geometries. All guideway is one-way only. It is important to construct complete one-way loops, and where loops interconnect to ensure consistent directions of flow. If a network is not complete in this sense the message at top right will red flag the failure. If you have not connected a complete loop the track ends will be a green node with a red border, while connected
nodes have a black border. If the gap is too small to introduce a new section of track, use the “Edit” menu to undo the last drawn section, and then reconnect.

A **demerge** or split can be created by positioning the mouse over the mid-section of a piece of guideway, holding the mouse button down and dragging and dropping. To create a **merge**, first click the mouse onto an existing network feature, hold down the mouse button and drag the mouse into a position on the mid-section of a piece of guideway. A merge will be created when you release the mouse button. Note that it is necessary to have a certain distance between nodes, so you may get an error message if you try and create a merge or demerge where there is insufficient space because it is too close to another node or station. Use “Edit” to pull the nodes further apart. If a guideway is drawn across an existing guideway it is assumed that it passes under or over that guideway: it connects to it only if it is explicitly drawn into a node on the existing guideway.

If you prefer, it is possible to draw the guideway first and add the stations later. If you click the mouse on an existing track node (a white square), a dialogue box will appear entitled ‘**Node type**.’ Choose station or depot, enter a name as appropriate and click OK. Use the same procedure to remove unwanted stations from a network – click on the station (or depot) and when the dialogue box appears, select ‘plain node’ and click OK. Similarly, an existing station can be renamed.

The network must contain at least one **Depot**. These must be located on the guideway in the same way as a station.
You can use the “Edit” button or “Edit” menu to change or undo any of your construction.

When you have finished entering the network, try running the simulation. Look at the message in the top right hand corner of the screen. This will say ‘All OK’ if it is possible to “Run”. If it is not possible to run the network you will see an error message here. Click on the button to get more information. If the track is overloaded you will need to reduce demand or provide alternative routings.

After Running the simulation and adjusting as required, the network can be saved whenever it is closed down by clicking on “Open” or “New” after stopping any running network. Saved networks can be recalled by using the “Open” command in the “File” menu and “Open Saved” in the window.

The appearance of the network can be changed by use of the “Simulation/Appearance” menu.

7. BACKGROUND MAP

It is normally easier to design a network if you use a background image, for example a map or an aerial photograph. It’s best to load this image first. Click ‘New’ in the file menu and this time select ‘Load map from a file’ and click ‘Browse.’ Once you have found the appropriate image file, click ‘Next.’ It is important to scale the map properly before you start drawing the network, and several features are provided to achieve this. You can enter the height or the width of the map (in km) then click ‘Update.’ You can also enter the scale factor if you prefer. It is only necessary to enter one of these parameters, click update and the other two parameters will be adjusted automatically. Most background images are too dark to work with, so adjust the ‘Fade’ slider until the background image is right. When you are satisfied, click ‘Finish.’ The background map of a network can be changed, rescaled or faded at any time by clicking on “Simulation” and “Background image” and adjusting as required.

8. PASSENGER DEMAND LEVELS

Once the simulation has run successfully, it is possible to evaluate your network design. The simulation runs for two hours of virtual time. Use the ‘Faster’ and ‘Fast forward’ controls to speed things up. At the end of the run, a set of results is displayed, which gives the total number of passenger groups using the system and some statistics on how long each group waited for a vehicle. You can copy these results into another program by right clicking on the results table.

To alter the relative numbers of passenger groups travelling to and from each station, click ‘Origin-Destination Matrix’ in the “Simulation” menu. Uncheck the box marked ‘Let the simulator choose the origin-destination matrix’ and it is then possible to enter
numbers directly into the origin-destination table. Origin stations are listed in the left
hand column, destination stations are listed across the top row.

Click and drag to highlight individual cells, entire rows or columns, or the whole matrix.
Right click brings up a menu including “Scale” and “Set”. Selecting either produces a
window in which the highlighted numbers can be multiplied by a scale factor, or set to
the required value. The number travelling into and out of each station is limited to 300 in
total. The display will turn red and give a warning if you set the demand levels too high.

9. EMPTY VEHICLE MOVEMENTS AND FLEET SIZE

The software automatically moves (red) empty vehicles around to balance the distribution
of available vehicles. If a loaded vehicle arrives at its destination station and there is no
empty berth, an empty vehicle at the station may be pushed out to make room for the
arriving vehicle, and will then be directed to another station where an empty vehicle is
required, or back to a depot.

At low levels of demand, each station will be given a minimum of two berths even if the
demand justifies only one berth, since the second “berth” represents space for a vehicle to
wait, if necessary. This simplified simulation will often fill both spaces with empty
vehicles, because it operates by always answering a passenger call as quickly as possible.
For this reason, at low demand this simulation tends to over-estimate the fleet size
required, and in practice it will be more economical to reduce the fleet size and allow
mean waiting times to increase slightly, since in these circumstances mean wait times
will be very low. This trade-off is not available here, but can be examined in ATS’s own
simulation tools.

At higher levels of demand, if waiting times are too high it is a good idea to introduce
more depots onto the network upstream of stations with unacceptably high waiting times:
in practice, these “depots” need be simply storage space for empty vehicles. In this
simulation, the same software is used to manage empty vehicle movements on all
possible different network geometries, so empty vehicle circulation might not be
optimum on certain types of network. For example, networks with small numbers of
stations spread over a wide area, or networks with too few depots, may need special
optimisation to achieve maximum efficiency. The software tools to perform this
optimisation are NOT available with this simulation, since they require an experienced
understanding of PRT operation to work effectively. As noted in the Introduction, ATS
Ltd will be happy to consult on the more advanced aspects of PRT design.

© ATS Ltd 2008  
Deleted: 1  
Deleted: 

Deleted: 1  
Deleted: 2007  

10